
Be More Productive using 
Word in Just Five Days 
While Saving Your Sanity in the Process 

Ok, right now you might find yourself with some extra time on your hands.  Not ideal, but it is an 
opportunity to learn a few tricks to make yourself more productive in Microsoft Word.  So, when 
this is over you will be ready to hit the ground running.  Leaving those who wasted this time in 
the dust.   

Productivity isn’t just doing work; it is doing it in the most efficient manner.  What I am going to 
show you, are tips and tricks in Word that you can use to not only do your work but do it more 
efficiently, resulting in more time for clients!  Now, these are not the only ways to be more 
productive, but the ones I felt would take the least time to show you and gave you the biggest 
bang for your buck.  I am going to break this information down into five days and each lasting no 
longer than the time to enjoy your beverage of choice!   

Here is a quick look at what I am going to talk about: 
● Day 1 - Template Documents
● Day 2 - Text Expander
● Day 3 - Macros
● Day 4 - Applying Styles
● Day 5 - Text blocks

I am going to start with something simple, but important -- templates.  Templates allow you to 
reuse documents, without the worrying about the problems that come with reusing a document 
(e.g. exposing another client’s information, errors of inclusion/omission, high risk of errors).  
Followed by a discussion of how using a text expander can eliminate a lot repeating yourself.  
On Wednesday, we are going to hit a hard topic, but once you understand Macros, it can be a 
game changer.  Thursday, we will cover how to apply styles to a document without tearing your 
hair out.  Finally, on Friday we will take it easy to prepare for the weekend and talk about how to 
use text blocks to simplify putting together a document.  You will need to be using a version of 
Word 2010 or greater (Word for Office 365, Word 2019, Word 2016, Word 2013, Word 2010).  

So, enjoy this weekend and I will see you bright and early on Monday to start our journey! 

Day One - Template Documents 
Hello and I hope the morning is off to a good start.  Before we get started, we need to handle a 
few things.  First, grab that beverage of choice.  Next, take the time to enjoy a few sips and 
prepare yourself mentally.  Not because the lesson is hard, but because I want you to focus on 



productivity through these next five days.  What I am showing you is nothing more than a simple 
tool to help you in the journey to eliminate those tasks in your life that are boring, repetitive, or 
error prone.  We only have so much time on this rock called Earth, don’t waste it doing work that 
doesn’t improve your or your client’s outcomes! 

Introduction 

Ok, hopefully, everyone is now ready to begin.  I want to first start out with what challenges we 
are going to solve.  We are going to work on reducing typing and errors.  We reduce typing by 
using templates, which are a special type of Word documents.  It allows you to set up styling, 
fonts, boilerplate text, company letterhead, etc. While avoiding the issues of reusing a document 
or what one ABA article calls it “Find, Replace, and Modify” (here is the link to the ABA article 
Document Assembly For Lawyers: Using Templates And Software).  While reusing a document 
isn’t bad per se, it opens you up to potential lawsuits if you forget to remove client information or 
leave out important legal text.  With better options available to you, why risk it? Without further 
ado, let get right to it, by showing you how to create a Word template. 

Creating a Word Template 
1. First, create a document and add any formatting you need.  Maybe you do a lot of

contract work, an ideal candidate for templating.  Or maybe a non-disclosure
agreement?

2. Once you feel it looks right, you will need to save the document as a template.  To do
this you need to click on File and then click on Save As.

3. Next, select a location to save the document.
4. Give the template a name you will remember and select Word Template (*.dotx) as the

file type.

5. Click Save.

https://www.americanbar.org/content/dam/aba/multimedia/cle/materials/2016/08/ce1608lpi.authcheckdam.pdf


Use your template to make a new document 

1. When you are ready to use your template, just go click File and then click New.
2. Next, click on the Personal (or some versions of Office Custom) button.

3. You should see your template.  Double click on the template and then you will see it,
ready for you to modify.  It is just that simple.

Conclusion 

So, there you go, day one is complete, and your beverage should still be just the way you like it.  
Don’t underestimate the power templates can bring to your firm.  I also hope that this example 
started your mind to wondering how tools like this can help you be more efficient and effective.  
Never stop asking yourself, “is there a better way to do this?”  Your time is valuable, don’t waste 
it on boring and repetitive work. 

Day Two - Text Expanders 

Introduction 

Ok, hopefully, everyone is now ready to begin and has their beverage of choice right beside 
them.  Today we are going to look at a solution to solving repetitive text.  Think of some small bit 
of text you are constantly having to type or always spelling wrong, such as an email address or 
legal term.  How about if you could shorten it to a few letters and then let Word expand it to that 
text, sans any typing errors?  Let’s look at how you can put this feature to use.  Also, put on that 
thinking cap to look and be on the lookout for other ways this could simplify your day!  



Using Autocorrect as a Text Expander 
1. Open Word and click on File and then click the Options button.
2. Look for the Proofing section and click on it.

3. Next click on AutoCorrect Options…

4. There will be a checkbox called “Replace text as you type.”  Check that option if it isn’t
checked already.

5. To add a new replace text, just enter in what you want to replace and what to replace it
with.  Hit the enter key or click the Add.  This will add it to the list below.



6. Selecting an item from the list, you can also replace or delete it.  So, if you added an
item for email that then changes, it is a simple thing to update it.  Deleting is even easier.

7. Once you are all done, click OK twice and you will be back at your document.  Try out
your new additions!

Note to use the option for formatted text (bolded, different fonts, etc.…), you need to have 
selected something before opening the AutoCorrect Options window.  Follow the below steps to 
handle those cases. 

1. First, type into Word, the phrase or text you want to produce.
2. Make any formatting changes, such as italicizing a word or making it bold.  I am using

some simple text with a portion of it being italicized.

3. Select and copy that text.
4. Now, go back to the proofing section, by click on File and then clicking on Options.

5. Click on the Proofing section and then click AutoCorrect Options…



You should see the text you copied in the With textbox and the formatted text option 
selected. 

6. Add the text you want to replace and then click Add or hit enter.
7. Click OK twice and you will be back at your document.

Conclusion 

Another day is complete, and your beverage of choice should still be at the right temperature.  
We have put another feather in our cap and ready to use when we need it.  Tomorrow we are 
going to tackle a bit more difficult topic, macros.  So, come prepared with a positive attitude and 
a readiness to learn.  Again, never stop asking yourself, “is there a better way to do this?”  Your 
time is valuable, don’t waste it on boring and repetitive work. 

Day Three - Macros 

Introduction 

Welcome back and happy hump day.  Today we are going to tackle a more difficult topic of 
macros, so I hope you have prepared a stronger version of your beverage of choice!  So, what 
are macros?  Well, it really is nothing more than a series of actions that you can execute as a 
single command.  Macro recorders are the programs that allow you to capture those actions.  
Word has one built into it, but you can buy macro recorders for other programs and even 
Windows and Macs.  Hint, this creates a huge opportunity for automation in other things you do.  
Need to create a new client folder with required documents, create a macro!   

Before we go much further, I need to mention that there are possible security risks in using 
macros.  Microsoft has done a lot to minimize this risk, but if you are not careful you can get into 



trouble.  So, unless you trust the source of a macro don’t use it.  If you get a macro enabled 
document from someone you don’t know or trust, don’t open it.  I am not trying to scare you into 
not using macros as they are an extremely valuable tool, but you do need to be careful, as 
Uncle Ben said, “with great power comes great responsibility!’ 

Ok, time to get back on topic.  Let’s look at how to create a macro in Word, starting with a 
simple example of inserting a section symbol (§).  Normally, you would need to go through a 
bunch of different steps to accomplish this.  Add up the number of times you need to do this, it 
gets expensive in wasted time.   

Creating a Simple Macro 
1. In an open Word document, click on the View tab.

2. You should see a Macros button, there is a small black arrow below the icon, click on
that and select Record Macro…

3. Type in a name for the macro.  I typed in InsertSectionSymbol, but you can use
something that makes sense for you.

Note: You will see a section called “Assign macro to.”  For now we are going to do 
nothing, but I will circle back and explain in a bit more detail.  Simply put, these just help 
us to define how we are going to execute the macro. 

4. Where it states “Store macro in:,” it defaults to All Documents (Normal.dotm).  This
means that the macro you are creating will be available in any document you work on.



Normally, this is what you would want, but you might have a macro only for the 
document you are currently working on, in which case you would select the current 
document. 

5. Click OK.
6. Now, the macro recorder is watching the actions we are taking.  So for this scenario, you

need to click on the Insert tab.

7. Click on the Symbol button.

8. Then click More Symbols…

9. Click on the Special Characters tab.

10. Look for the character called Section and select it.



11. Click Insert and then click Close.
12. So, we have accomplished all we wanted it to, it is now time to stop the recording.

There are a couple of ways to stop the macro recording.
a. You can click View, click on Macros, and then click on Stop Recording.

b. You can click on a button in the lower left corner to stop the macro recording.  It
looks like a square with a light gray border.

13. With the recording done, you can now view it in the list of macros.  If you go back to the
View tab and click on the Macros button, you should now see it.

14. To run it, you just need to select the macro and click Run and it will insert a section
symbol where your cursor was on the document!

Executing a Macro 

Now, doing this every time is not very convenient and isn’t any improvement over what we had 
to do before.  So, let’s talk about ways we can simplify this.  Remember when we came across 



that section called Assign the macro to?  Well, those were just shortcuts to what we are going 
to do next.  The typical way you execute macros is either through a button or a keyboard 
shortcut.  If you go with a button, it would be placed in the menu bar or the quick access toolbar.  
Let’s take a look at how to set up each option. 

Using a Keyboard Shortcut 
1. Let’s create a new macro.  Don’t worry, we will fix our first macro to use a button later.

For now repeat the steps 1-4 from the previous section.  When you see the section
Assign macro to, click on the Keyboard button.

2. A window will pop up and in the “Press new shortcut key.”  Click in this box and here is
where you will enter the short cut you want to use to execute your macro.  I chose
alt+i,s.  Which means I held down on the Alt key and hit the i key and then the s key.
You can enter any keyboard combination you want, but be aware that some are already
in use, such as ctrl+v (paste).  On the plus side, If you select one that is in use, it will
display that as “Currently assigned to: [function]” under the Current keys: text box.

3. Click the Assign button and then click Close.
4. You will now return to the document and the macro recorder is running.
5. Pick back up on step 7 through to 12.



6. Test out your keyboard shortcut and you should see the section symbol be inserted
where you have the cursor placed.

Using a Button 
1. Now, we are going to reuse the macro we created before (I called mine

InsertSectionSymbol).
2. Click on File and then click Options.
3. Next, click on Customize Ribbon.

4. Under Choose commands from, click Macros.

5. Click the macro you want.
6. Under Customize the ribbon, click the tab and custom group where you want to add the

macro.
Note: If you don't have a custom group, click New Group. Then click Rename and type a
name for your custom group.



7. Click Add and you should see your macro in the group you selected.

8. Select the macro you just added and click Rename to choose an image for the macro and
type a more user-friendly name.



9. Click OK twice.
10. Now click on the Insert tab and you should see your new button in the Legal Symbols group.

11. Click on it and you should see the section symbol be inserted where you have the cursor
placed.

Conclusion 

Phew, this was a lot longer than the other days, but your beverage of choice should still be 
good.  Don’t worry we will be tackling a easier topic tomorrow when we talk about styles.  This 
should be a lot easier to get through and still enjoy your beverage of choice at the right 
temperature.  For now, I hope you see the possibilities for macros.  Realize that this is just 
barely scratching the surface.  Macros can do a lot more, so when you ask yourself, “is there a 
better way to do this,” consider that the answer might be using a macro!  Remember your time 
is valuable, don’t waste it on boring and repetitive work.  

Day Four - Styles 

Introduction 

I assume by now that you have that beverage of choice nearby, so let’s get started.  Today we 
are going to talk about styles.  Word Styles are nothing more than predefined fonts and 
formatting that can be applied to a document, making your documents have a consistent look.  
First, let’s look at how you apply a style.  Then we will look at how to create a new style.  So, 
let’s begin. 

Selecting a Style 
1. As always, start by opening Word.
2. Ensure you are on the Home tab, where you will see a list of styles towards the right of

the menu bar.



3. Select the text you want to format.  If you want to format the whole document, use ctrl+a
to select the whole document.

4. You can hover over the styles (without clicking) and it will give you a preview of how the
style will look once applied.  If you don’t see a style you want, you can click on the more
button to see additional styles (if you have any).

5. Once you find one you want, click on it and viola, consistent styling.

Now, you may have a style that hasn’t been predefined for you.  In that case you can either 
modify an existing style or create a new one.  We will look at creating a new style as modifying a 
style is very similar to creating a new one, with less steps.  To modify a style, just hover over the 
one you want to modify.  Right click and then select Modify…  With that all set, let’s create our 
new style. 

Creating a Style 
1. Select the text you want to base the style on.  Ideally, you have a document with the look

and feel you want, but it isn’t required.
2. Click on the more button by the Styles section and click on Create a Style.

3. Give the style a name.



4. If the text you selected already has all the formatting you want to apply, just click OK and
now you will see the style among all the other styles.

5. If you need to modify the styling, click Modify.
a. A window should pop up and allow you to make the changes you want.  It is

beyond our talk today to discuss all the options, but at the end I will have links to
resources that go into more detail.

b. Click OK.

6. Now you can use this style like any of the predefined ones.

Conclusion 

One day left and your beverage should be just right.  Tomorrow we are going to talk about text 
blocks.  The premise is similar to text expanders, but this is related to much larger sections of 
text.  A real help when you need to add boilerplate clauses.  See you tomorrow and don’t forget 
to bring your favorite beverage along! 



Day Five - Text Blocks 

Introduction 

We are finally on the last day and I have left it simple to finish off the week.  There is a lot to 
process from this week and you really need to practice making this a useful part of your toolkit.  
Today we are talking about text blocks or as they are called in Word - AutoText.   

Creating a AutoText Snippet 
1. First, type the text you want to be used.  In this example I used an address.
2. Select the text and click alt+F3.
3. This will pop up a new window.  Add a name that makes sense to you and put in a

description if it needs one.  Select any other options that you need and click OK.

Using AutoText 
1. To use our new snippet, we just need to put the cursor where we want the text.
2. Next, go to the Insert tab and click on the Quick Parts button.  Hover over AutoText

and then select the snippet you want.

3. Then just click it to insert the text.



Conclusion 

Look, I taught you some good stuff here and your beverage of choice is still at the perfect 
temperature. If you want more tips on how to automate your practice, give me a call or email 
me. In the time it takes for a coffee to cool down to the perfect temperature, I can set up a virtual 
meeting or phone appointment to help you make your practice more efficient, profitable and 
maybe even dare I say it enjoyable.  Contact me at 207-740-5709 or email me at 
wwade@dirigosoftwaresolutions.  Please don’t hesitate to reach out to me, I especially 
appreciate calls or emails about how you have put technology to use in your own practice.  For 
now, good luck and go enjoy that beverage, you earned it! 

Helpful References 

● Office Support: Microsoft Office help and training I use this site extensively when I am
working with Word.  While it is not legal specific, much of what it teaches can be applied
to any business including the business of law.

● Lawyerist.com I have read some good articles on this site and in particular I liked this
one - Microsoft Word for Lawyers: A Complete Guide (2020) It had a great section on
styles that I recommend you take a look at.

● The American Bar Association The ABA does a lot of research into how technology
impacts the legal profession. If you weren’t aware, the ABA puts out a yearly tech survey
and you can find the latest here.  It is where I found this useful article - Document
Assembly For Lawyers: Using Templates And Software

https://support.office.com/
https://lawyerist.com/
https://lawyerist.com/technology/microsoft-office/word/
https://www.americanbar.org/
https://www.americanbar.org/news/abanews/aba-news-archives/2019/10/aba-releases-2019-techreport-and-legal-technology-survey-report-/
https://www.americanbar.org/content/dam/aba/multimedia/cle/materials/2016/08/ce1608lpi.authcheckdam.pdf
https://www.americanbar.org/content/dam/aba/multimedia/cle/materials/2016/08/ce1608lpi.authcheckdam.pdf
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